System 800xA
Central Licensing System

System Version 6.0
NOTICE

This document contains information about one or more ABB products and may include a description of or a reference to one or more standards that may be generally relevant to the ABB products. The presence of any such description of a standard or reference to a standard is not a representation that all of the ABB products referenced in this document support all of the features of the described or referenced standard. In order to determine the specific features supported by a particular ABB product, the reader should consult the product specifications for the particular ABB product.

ABB may have one or more patents or pending patent applications protecting the intellectual property in the ABB products described in this document.

The information in this document is subject to change without notice and should not be construed as a commitment by ABB. ABB assumes no responsibility for any errors that may appear in this document.

Products described or referenced in this document are designed to be connected, and to communicate information and data via a secure network. It is the sole responsibility of the system/product owner to provide and continuously ensure a secure connection between the product and the system network and/or any other networks that may be connected.

The system/product owners must establish and maintain appropriate measures, including, but not limited to, the installation of firewalls, application of authentication measures, encryption of data, installation of antivirus programs, and so on, to protect the system, its products and networks, against security breaches, unauthorized access, interference, intrusion, leakage, and/or theft of data or information.

ABB verifies the function of released products and updates. However system/product owners are ultimately responsible to ensure that any system update (including but not limited to code changes, configuration file changes, third-party software updates or patches, hardware change out, and so on) is compatible with the security measures implemented. The system/product owners must verify that the system and associated products function as expected in the environment they are deployed.

In no event shall ABB be liable for direct, indirect, special, incidental or consequential damages of any nature or kind arising from the use of this document, nor shall ABB be liable for incidental or consequential damages arising from use of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

This document and parts thereof must not be reproduced or copied without written permission from ABB, and the contents thereof must not be imparted to a third party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and may be used, copied, or disclosed only in accordance with the terms of such license. This product meets the requirements specified in EMC Directive 2004/108/EC and in Low Voltage Directive 2006/95/EC.

TRADEMARKS

All rights to copyrights, registered trademarks, and trademarks reside with their respective owners.

Copyright © 2003-2016 by ABB.
All rights reserved.

Release: September 2016
Document number: 2PAA111691-600 C
Table of Contents

About this User Manual
User Manual Conventions ........................................................................................................9
  Warning, Caution, Information, and Tip Icons .................................................................10
Terminology..........................................................................................................................10

Section 1 - Overview
ABB 800xA License Model ....................................................................................................12
  Design Mode ......................................................................................................................13
  Production Mode ..............................................................................................................13
  License Types ..................................................................................................................14
    Production System License ...........................................................................................14
    Engineering License ......................................................................................................14
    Channel License ............................................................................................................15
    Internal License .............................................................................................................15
    Demo license ................................................................................................................15
CLS Server and Client ..........................................................................................................15
800xA Single Node ..............................................................................................................16

Section 2 - Workflow

Section 3 - Manage the License
Obtain the Machine ID ........................................................................................................19
  Read the Machine ID from a Dongle ..............................................................................20
  Read the Machine ID Using the License Entry Tool ....................................................21
  Read the Machine ID from the MAC Address ...............................................................21
Request the License ............................................................................................................22
<table>
<thead>
<tr>
<th>Section 4 - Load the License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loading the License</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section 5 - Assign the Licenses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup and Restore</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section 6 - License Usage Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessing License Usage Report</td>
</tr>
<tr>
<td>License Usage Report Display</td>
</tr>
<tr>
<td>Time Limited License Type</td>
</tr>
<tr>
<td>Permanent License Type</td>
</tr>
<tr>
<td>License Usage Report</td>
</tr>
<tr>
<td>Hardware License Usage Report</td>
</tr>
<tr>
<td>Software License Usage Report</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section 7 - Control Hardware Report Tool</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appendix A - Diagnostic Information</td>
</tr>
<tr>
<td>License Assignment Editor</td>
</tr>
<tr>
<td>License Status Viewer</td>
</tr>
<tr>
<td>License Violations</td>
</tr>
<tr>
<td>Temporary Licenses</td>
</tr>
<tr>
<td>CLS Relocation</td>
</tr>
<tr>
<td>CLS Installation</td>
</tr>
<tr>
<td>Internet Information Services</td>
</tr>
<tr>
<td>Workstation Operating System</td>
</tr>
<tr>
<td>Server Operating System</td>
</tr>
<tr>
<td>License Server Setup</td>
</tr>
<tr>
<td>Relocate the License Server Node</td>
</tr>
<tr>
<td>Locate the License File</td>
</tr>
<tr>
<td>Unavailable Machine IDs</td>
</tr>
<tr>
<td>Dongles</td>
</tr>
<tr>
<td>MAC Address</td>
</tr>
<tr>
<td>Section</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>Common Error Messages</td>
</tr>
<tr>
<td>Temporary Licence Error Message</td>
</tr>
<tr>
<td>System Events for License Violations</td>
</tr>
<tr>
<td>Appendix B - Related Documentation</td>
</tr>
<tr>
<td>Revision History</td>
</tr>
<tr>
<td>Index</td>
</tr>
</tbody>
</table>
About this User Manual

Any security measures described in this user manual, for example, for user access, password security, network security, firewalls, virus protection, and so on, represent possible steps that a user of an 800xA System may want to consider based on a risk assessment for a particular application and installation. This risk assessment, as well as the proper implementation, configuration, installation, operation, administration, and maintenance of all relevant security related equipment, software, and procedures, are the responsibility of the user of the 800xA System.

This user manual describes:

- The licensing mechanism used in the 800xA System.
- How to obtain the machine ID and obtain the Licenses.
- How to assign the licenses and view the status.
- Troubleshooting information.

Unless otherwise noted, the versions of all 800xA Base System and Functional Area software described in this user manual are the latest release of 800xA 6.0.

User Manual Conventions

Microsoft Windows conventions as defined in the *Microsoft Manual of Style* are normally used for the standard presentation of material when entering text, key sequences, prompts, messages, menu items, screen elements, and so on.
Warning, Caution, Information, and Tip Icons

This user manual includes Warning, Caution, and Information where appropriate to point out safety related or other important information. It also includes Tip to point out useful hints to the reader. The corresponding symbols should be interpreted as follows:

Electrical warning icon indicates the presence of a hazard which could result in electrical shock.

Warning icon indicates the presence of a hazard which could result in personal injury.

Caution icon indicates important information or warning related to the concept discussed in the text. It might indicate the presence of a hazard which could result in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.

Tip icon indicates advice on, for example, how to design your project or how to use a certain function.

Although Warning hazards are related to personal injury, and Caution hazards are associated with equipment or property damage, it should be understood that operation of damaged equipment could, under certain operational conditions, result in degraded process performance leading to personal injury or death. Therefore, fully comply with all Warning and Caution notices.

Terminology

A complete and comprehensive list of terms is included in Table 4. The listing includes terms and definitions that apply to the 800xA System where the usage is different from commonly accepted industry standard definitions and definitions given in standard dictionaries such as Webster’s Dictionary of Computer Terms.
Section 1  Overview

The latest version of this manual is available in ABB SolutionsBank.

The 800xA System licensing is the means to scale a system to fit the actual needs. By offering the system as a base system with options, with scaled tags, logs, etc., the system can be cost wise optimized for each use case. When needed, expansions can be purchased and the system grows with the customer's needs.

It is important to recognize that installation is separate from licensing. Installation is never prevented due to lack of licensing.

The system is identified to the license function by means of either a license dongle which is purchased separately, or by the MAC address of one of the computers in the installation.

The licensed rights are available in the license file, which is retrieved from ABB and installed in the system. The license file contains license features that determine the options and the amounts that are granted.

There are four basic types of licensed features:

- System feature - for system-wide functions available across many or all nodes of the system. They are indicated **one per system** in the price list.
  
  An example of this type is the connect options.

- System feature with scaling - for system-wide features. The scaling of no. of tags, procedures, logs, and so on. are examples of this type of feature.

- Client feature - for client-specific functions applying to a single client node in the system. Examples of this type are: Operator Workplace, Engineering Workplace, and Batch Client.
Hardware feature - this feature determines which hardware units are granted for use. Each hardware unit, I/O, communication, and CPUs, comes with a license. As hardware units are purchased, license features become available in the license file.

At upgrade, the current usage of hardware has to be reported back to ABB so that the appropriate licenses can be registered into the license file. A tool is available for that purpose, which must be run on the system to be upgraded. It is important to run the tool on a system with all Hardware modules installed.

800xA Central Licensing System (CLS) software follows the System 800xA life cycle and it is part of System 800xA media. In system, CLS can be configured as follows:

- Server.
- Client.
- 800xA Single Node (Stand-alone).

The Central Licensing System (CLS) also has a Central Licensing System extension that adds the following aspects to the 800xA System.

- License Usage aspect.
- Library License Definition aspect.
- System Release Info aspect.

**ABB 800xA License Model**

There is a new licensing model introduced in System 800xA 6.0. This model tracks software and hardware delivered to each system. The license concept helps the user by indicating the features that are missing and in turn the annoyance is delayed for some time, to allow users to test the functionality early in the system life cycle. Users can test the required functions and view the usage report to update the license.

The new licensing model adheres to the life cycle of an 800xA System, which in turn can be defined in two phases, the **Design Phase** and **Production Phase**. When the system is running in design phase the license required will be the design mode license and when the system is running in Production phase the license required will be the production mode license. The selection is enabled in SoFa once the user has ordered a **Production Mode License**.
Design Mode license is used during the first phase of system design and system engineering. This is the phase where the bulk of project engineering is made. In this phase any feature can be used to its full extent. There is no enforcement of individual licenses, which means users can build and test their applications without being annoyed by license messages. A License Usage Report keeps track of current license usage in the system.

In this mode, any operator related activities like using Operator Workplace, Opening Faceplates and so on will be treated as license violations. Any attempts to perform an operator related activity will lead to a violation message in the form of a semi-transparent text appears as **Design Mode, Licensed for Engineering only**.

When time limited license is used, the license expires after completion off 18 months.

The 18 months of design mode is based on License file creation date.

### Production Mode

In production mode the system is connected to a process. Licenses are actively monitored with the purpose to validate the usage against what has been ordered. Enforcement of individual license features is active, and the user is informed about the possible license violations. Users are allowed to test all functions and there is no license violation message displayed in system for first 90 days.

The initial 90 days of production mode is based on License file creation date.

In this mode, system events are generated whenever there is a license violation.
License Types

There are different license types available as end-user license and additional license types:

**End-user License Types:**
- Production system license.
- Engineering license.

**Additional License Types:**
- Channel license.
- Internal license.
- Demo license.

**Production System License**

This license type is intended for systems that actively control user’s plants. The license is by default in design phase, and can be used for engineering for any duration. Once the user decides so it is transitioned into production phase.

This license is purchased through the wizard, and SoFa gets the information about its scope from BOL/OMS/SAP. Even if the user starts engineering and does that for significant time, the license must be ordered in the normal way. An initial purchase enabled for engineering in the design phase.

**Engineering License**

This license type is intended for customers who want an engineering system as complement to the production system. This license type can never be configured so that it controls a plant that is it remains in the design mode forever.

This license is purchased by referring to the production license, and it is function wise a replica of the production system. If a customer has several production systems the customer can use a replica of the largest system or have individual engineering license replicas for each system.

This license type is also used by users who develop their own add-on to an 800xA system, such as own aspect systems or libraries. In those cases additional development licenses are required.

This license is a time limited license.
Channel License

This license type is intended for application engineering by channel partners and ABB channels. System is in design mode. This license is time limited to 18 months.

This license is a time limited license.

Internal License

This license type is intended for demo systems, training, and education systems that are permanently installed in demo rooms and training facilities. It is also used for ABB internal development (R&D). System is in production mode. This license is time limited to 18 months.

This license is a time limited license.

Demo license

This license type is intended for system demonstrations and previews. System is in design mode. This license is time limited to 3 months.

This license is a time limited license.

CLS Server and Client

The designated node, typically the Primary Aspect Server node contains the License Server (CLS Server), thus becoming the License Server node. This server dynamically distributes the available licenses as it is required to be present on all other nodes (License Clients) within the system. As an alternative, licenses may also be reserved for use by a particular node.
800xA Single Node

800xA Single Node (Stand-alone) option enables installation of Client Licensing software on a single node workstation without being dependent on Internet Information Services (IIS).

All communications through IIS are bypassed. This option is useful for installations on any single node workstation, laptop, and so on.

This option does not provide the License Assignment Editor, therefore the total in use count for each feature can be seen through the License Usage Aspect and the Software Feature Agent (SFA) Tester.
Section 2  Workflow

The workflow for the Central Licensing System is shown in Figure 1. Clicking on a box with blue text will take you to the associated procedure.

There are two branches in the workflow. One for obtaining the license key before beginning the installation, and one for obtaining the license key after beginning installation. It is highly recommended that you obtain the license key before beginning the installation and integrate it into System Installer during the planning phase. Obtaining the license key after beginning the installation will require halting System Installer while you wait to fill out and send the License Request Form to the ABB license and Automation Sentinel Administration System (SoFa), and then receive the license keys from SoFa.

Refer to Appendix A, Diagnostic Information if problems occur with the Central Licensing System.
Figure 1. Central Licensing System Workflow
Section 3  Manage the License

Licenses are obtained from the ABB license and Automation Sentinel Administration System (SoFa). This topic describes how to obtain the machine ID and request the License. The License must be loaded on the node where the Central Licensing Server software is installed when they are received from ABB (typically the Primary Aspect Server node).

Obtain the Machine ID

There are two types of machine IDs that the ABB licensing program supports:

- A removable dongle (hardware key).
- The fixed MAC address of a network adapter.

Each of the machine ID types has advantages and disadvantages.

Using the MAC address as a machine ID is generally more convenient. However, if the network adapter is ever replaced or permanently removed from the node, a new set of Licenses will be required.

The dongle is a copy protection device that attaches to a USB port of the node.

Some advantages of a dongle are:

- The dongle can be moved to another node without needing to get new License. However, dongles can only be attached to a single node at any given time.
- Other machine IDs may need to be replaced to upgrade the software. New License must then be requested. However, there is no need to replace the dongle with a new one.
Read the Machine ID from a Dongle

To read the machine ID from a dongle:

1. Order the dongle from ABB.
2. Each USB dongle is labeled with its unique machine ID. The label looks like Figure 2, where the machine ID is as indicated.

3. Record the machine ID.
4. Proceed to Request the License.

Figure 2. Dongle Machine ID
Read the Machine ID Using the License Entry Tool

To use the License Entry Tool to obtain the machine ID:

1. To launch the License Entry Tool, select:
   
   ABB Start Menu > ABB Industrial IT 800xA > System > Licensing > License Entry

   For more information on ABB Start Menu, refer to System 800xA Tools (2PAA101888*).

2. Select:

   Machine IDs > Available IDs...

   from the menu to display the Installed Machine IDs dialog box.

3. Record the machine ID displayed in the Machine IDs dialog box.

4. Proceed to Request the License.

Read the Machine ID from the MAC Address

To use the MAC address as the machine ID:

1. Launch a Windows Command Prompt window.

2. Enter: `ipconfig/all`.

3. Read the line for Physical Address under the information for the network adapter. If the node has two network adapters, two addresses will be shown.

4. Proceed to Request the License.

The permanent license is tied to the submitted machine ID. If the network adapter is removed or replaced, the license will be invalidated.
Request the License

To request License (unless told otherwise by an ABB representative):

1. Obtain the machine ID of the License Server node (refer to Obtain the Machine ID).

2. Locate and have available the registration license numbers found on the license certificate form shipped with the software.

3. Complete the License Request Form shipped with the software. Follow the instructions found on this form.

Be sure to enter a valid e-mail address on the License Request Form.

4. Fill in the License Request Form as necessary.

5. Send the License Request Form to the ABB Software License Administration System using one of the methods on the registration form.

6. Wait for the License to be returned. The method by which the License will be returned is selected on the License Request Form:
   – Internet mail.
   – Postal mail.
   – Fax.

Internet mail is recommended so the License will be returned as an attached license (.sla) file. This is the format required by the License Entry Tool. Detach the file from the Internet mail and save it to a location on the License Server node where it may be accessed by the System Installer.
Section 4  Load the License

This topic is valid if you have received the License after installing the 800xA System.

All License for 800xA System software must be installed before using the applications. Install the License before attempting any post installation procedures, as some procedures may require the License to be in place.

Loading the License

To load the License, launch the License Entry Tool from the license server.

1. Select:

   ABB Start Menu > ABB Industrial IT 800xA > System > Licensing > License Entry

   For more information on ABB Start Menu, refer to [10] in Table 4.

2. Select:

   File > Load/Replace Licenses...

   in the License Entry Tool as shown in Figure 3.
3. The **Open** dialog box appears. Browse the license file (.sla), which contains the License and click **Open**.

4. If a License is already installed in the system, the “Overwrite existing license data for 800xA” message (**Figure 4**) appears. If required, click **Yes** to load the current License.

![License Entry Tool](image)

**Figure 3. License Entry Tool**

![Overwrite existing license data for 800xA Message](image)

**Figure 4. “Overwrite existing license data for 800xA” Message**
Section 4 Load the License  

Loading the License

5. View the installed License in the **License Entry** Tool based on License Group. **Figure 5** shows the License installed for the 800xA basic system functions.

![ABB License Entry](image)

**Figure 5. Browsing Licenses on a License Group Basis**

6. Select:

**File > Exit**

to exit the **License Entry** Tool when completed.

License file can also be loaded by using **View and Load License file** option. Using this option user can view the available license features and SFA_ID in the license file before loading.

For loading the extension license file, use **Load/Replace Licenses** or **View and Load license file** option; if the extension license file has different SFA_ID in comparison with previously loaded license file.
Section 5 Assign the Licenses

This topic is not necessary if the license assignment was integrated with System Installer during the planning phase (unless you want to manually change the license assignment at a later time).

The Central Licensing System dynamically distributes the available licenses as they are needed to all the nodes in the 800xA System. However, the License Assignment Editor allows licenses to be permanently assigned to a particular node.

To assign a license to a particular node:

1. From the License Server node, select:
   ABB Start Menu > ABB Industrial IT 800xA > System > Licensing> License Assignment Editor

   For more information on ABB Start Menu, refer to [10] in Table 4.

2. This launches the License Assignment Editor as shown in Figure 6. Enter the name of the node in the Select a Node or Application box.

3. Click Add. The node name will appear in the Assigned Features box.

4. Select the node name in the Assigned Features box.

5. Select the type of license to be assigned in the Available Licenses area.

6. Enter the number of licenses (of the type selected) that will be assigned to the node in the Number box.

7. Click Assign.

8. Click Save. This will cause the licenses to be allocated as specified.

If necessary, licenses will be removed from existing nodes to meet the specified license allocation.
9. Repeat this procedure as required.

Backup and Restore

License assignments are stored in XML format in the following file:

Install Drive:\Program Files (x86)\ABB Industrial IT\ABBLicense\Licenses\LicenseFeatureAssignment.xml

This file can be copied for backup or replaced with a backed up copy after re-installing the CLS software. If this file is restored from a backup, restart the License Server node or restart IIS in order for the change to take effect.

Un-installing the CLS software does not remove LicenseFeatureAssignment.xml and reinstalling the CLS software will not overwrite it.
Section 6  License Usage Report

The License Usage report provides license usage details for hardware and software features in the system.

Accessing License Usage Report

The License Usage Report can be accessed by navigating through the following path:

ABB Start Menu > ABB Industrial IT 800xA > System > Licensing > License Status Viewer > Tools > License Usage Report

For more information on ABB Start Menu, refer to [10] in Table 4.

License Usage Report Display

The automatic popup of license usage report takes place in Design mode. The delays of the automatic popup depends on License Types.

Time Limited License Type

License Usage report popup appears once in 22hrs after completion of 12 months and will provide the information about additional license required for the system. The user has to acknowledge the popup to close the License Usage Report, refer to License Types.

The initial 12 months of a time limited license is based on License file creation date.
Permanent License Type

License Usage report popup appears once in 22hrs and will provide the additional license required for the system. The user has to acknowledge the popup to close the License Usage Report.

License Usage Report

In the License Usage Report, there are two tabs:

- Hardware License Usage Report.
- Software License Usage Report.

Hardware License Usage Report

Displays the list of hardware license features with the actual and configured usage and provides following information. Figure 7 shows the Hardware License usage Report.

- **Feature**: Name of the Hardware Feature.
- **Available Licenses**: Number of licenses available for each hardware feature.
- **Actual Usage**: Number of licenses used for each hardware feature.
- **Configured Usage**: Number of hardware features that are configured and are not downloaded to controller.
- **Additional Required**: Indicates the number of additional licenses that are required.
- **Max Requested**: Indicates the maximum number of licenses that are requested in the system during the last 90 days.
Software License Usage Report

Displays the list of software license features with the available licenses and the actual usage. Figure 8 shows the software features report.

- **Project Group**: Name of the Group.
- **Feature**: Name of the software feature.
- **Available Licenses**: Number of licenses available for each software feature.
- **Actual Usage**: Number of licenses used for each software feature.
- **Additional Required**: Indicates the number of additional licenses that are required.
- **Max Requested**: Indicates the maximum number of licenses that are requested in the system during the last 90 days.
License Usage Report also displays the following data as in the Table 1:

**Table 1. License Usage Report**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer</td>
<td>Customer Name</td>
</tr>
<tr>
<td>System ID</td>
<td>Sentinel ID</td>
</tr>
<tr>
<td>HW Report Date</td>
<td>Date of the Hardware licence count</td>
</tr>
<tr>
<td>Sentinel</td>
<td>Sentinel Expiry Date</td>
</tr>
<tr>
<td>System Phase</td>
<td>Defines Project Life Cycle phases,</td>
</tr>
</tbody>
</table>

**Export** option is used to generate license usage report in .xml format and provides license details for hardware and software features in the system. The .xml file is used to get License file from the ABB license and Automation Sentinel Administration System (SoFa).
Section 7  Control Hardware Report Tool

The license model enforces licensing for the 800xA Hardware components including controllers and communication interfaces that has changed beginning with System 800xA Version 6.0. Each installed 800xA Hardware components requires a separate Hardware license.

ABB requires data from the existing system in order to generate hardware license for each hardware component. The data is collected by running the *ABB Control Hardware Tool (2PAA114472*) in the existing system. This tool is available in ABB SolutionsBank.

Run Control Hardware Report Tool as a Pre-Upgrade Procedure in the source system to get the 800xA Hardware component details.

Verify 800xA System is up and running. Ensure all the required control projects are online.

1. Download the Control Hardware Report Tool from ABB SolutionsBank.
2. Copy the **ABBControlHWReport.exe** into the local drive of the engineering client node.
3. Double-click the **ABBControlHWReport.exe** to run the tool.

The hardware data will be collected in a .bin file. The output .bin file will be located in the location where **ABBControlHWReport.exe** is launched. The .bin file is used to get License file from the ABB license and Automation Sentinel Administration System (SoFa).

Control Hardware Report Tool must be used only for AC 800M hardware to collect hardware data.
Appendix A  Diagnostic Information

This topic provides diagnostic information for the Central Licensing System.

License Assignment Editor

To display a complete listing of all the currently assigned licenses and the nodes they are assigned to:

1. From the License Server node, Open License Assignment Editor.
2. This launches the License Assignment Editor as shown in Figure 9. Click Diagnostics to view the listing.

![License Assignment Editor](image)

*Figure 9. License Assignment Editor*

**License Status Viewer**

To open license status viewer user must have administrator rights.

The License Status Viewer (Figure 10) is an application that can be used to diagnose licensing problems. The License Status Viewer is installed with the License Client and is therefore available on every node running the 800xA System software.

License Status Viewer provides details on License Violations and Temporary Licenses if available in system.
Select:

**ABB Start Menu > ABB Industrial IT 800xA > System > Licensing > License Status Viewer**

For more information on **ABB Start Menu**, refer to [10] in **Table 4**.
License Violations

If license violation messages (Applications are running Without Valid Licenses) appear, use the License Status Viewer to determine which licenses are in violation.

To save this list to a text file:

1. Open License Status Viewer.
2. Select:
   - File > Save
3. Enter a file name and browse to the directory in which to save the file.
4. Click Save to save the file.

Temporary Licenses

If temporary license messages appear, (Applications are running with Temporary Licenses. This computer is unable to communicate with the License Server.) use the License Status Viewer to determine the connection status of the CLS server. The CLS connection status is listed at the bottom of the License Status Viewer. A typical problem is that the License Client is not pointing to the node running the License Server. If this occurs, refer to CLS Relocation.

CLS Relocation

This section provides description to relocate the existing CLS Server usually hosted on the Primary Aspect Server to another server preferably Secondary Aspect Server, if the existing CLS Server is not available.

New CLS Server should be installed and configured manually incase it is not already done. Follow manual procedures mentioned in the subsequent chapters to install and relocate the CLS Server.

CLS Installation

Microsoft Internet Information Services (IIS) components must be enabled on License Server node before setting up a License Server by installing the CLS Server component.
Microsoft Internet Information Services (IIS) components must be enabled on CLS, Asset Optimization server, Melody server, and Harmony server nodes. There are different procedures for the Workstation Operating System and the Server Operating System.

**Workstation Operating System**

Perform the following procedure to enable the required IIS components on the Workstation Operating System.

1. Open Windows Control Panel.
2. Change Windows Control Panel to Large Icons view.
3. Click **Programs and Features**.
4. Click **Turn Windows features on or off** in the left pane to launch the **Windows Features** dialog box.
5. Navigate to and expand the following:
   - **Internet Information Services > World Wide Web Services**
6. Select the following:
   - Every check box **except WebDAV Publishing** under **Common HTTP Features**.
   - Every check box **except Custom Logging and ODBC Logging** under **Health and Diagnostics**.
   - The **Static Content Compression** check box under **Performance Features**.
   - The **Request Filtering, Basic Authentication and Windows Authentication** check boxes under **Security**.
   - Every check box **except CGI and WebSocket Protocol** under **Application Development**.
7. Navigate to and expand the following:
   - **Internet Information Services > Web Management Tools**
8. Select the following:
   – The IIS Management Console and everything except IIS 6 WMI Compatibility and IIS 6 Scripting Tools under the IIS 6 Management Compatibility check boxes under Web Management Tools.

9. Enable every check box under FTP Server.

Server Operating System
Perform the following procedure to enable the required IIS components on the Server Operating System.

1. Open Windows Control Panel.
2. Change Windows Control Panel to Large Icons view.
3. Click Programs and Features.
4. Click Turn Windows features on or off in the left pane to launch Server Manager initial screen.
5. Select the **Installation Type** and click **Next** as shown in **Figure 11**.

![Figure 11. Select Installation Type](image-url)
6. Select a Server or a Virtual Hard Disk on which to install roles and features and click **Next** as shown in Figure 12.

![Select Destination Server](image)

**Figure 12. Select Destination Server**

7. Select the Server Roles in the left pane.
   a. If this is the node that will serve as the AO Server node, check to see if **Application Server** (refer to Figure 13) and **Web Server (IIS)** (refer to Figure 14 and Figure 15) are in the Installed Roles pane of the Roles Summary.
   b. If this is not a node that will serve as the AO Main Server node, check to see if **Web Server (IIS)** (refer to Figure 14 and Figure 15) is in the Installed Roles pane of the Roles Summary.
8. Select the **Web Server (IIS)** (refer to Figure 14 and Figure 15) and/or **Application Server** (refer to Figure 13) check boxes (depending on the current configuration) and click **Next** to install the features.

![Select Server Roles](image)

*Figure 13. Select Server Roles*
Figure 14. Select Role Services - Part 1
Appendix A  Diagnostic Information 

License Server Setup

Set up a License Server by installing the CLS Server component on the Primary Aspect Server node.

To install the required licensing components on the designated License Server:

1. Double-click ABB Central Licensing System.msi.
2. Follow the Installation Wizard to complete the installation. Perform the following when the indicated dialog boxes appear:

*Figure 15. Select Role Services - Part 2*

License Server Setup

Unless otherwise specified, log on as the Install account user from this point through the completion of the installation and post installation process.

Set up a License Server by installing the CLS Server component on the Primary Aspect Server node.

To install the required licensing components on the designated License Server:

1. Double-click ABB Central Licensing System.msi.
2. Follow the Installation Wizard to complete the installation. Perform the following when the indicated dialog boxes appear:
a. **Select Components dialog box:** Select the **Server** option. All required client components are also installed as part of the server installation.

b. **Username and Password dialog box:** Enter the username and password for the 800xA Service account user (refer to [3] in Table 4). Use the `domain\user` syntax to specify a domain account.

### Relocate the License Server Node

If the License Client is not pointing to the correct License Server node, or the License Server has been relocated or renamed, change it by using the License Status Viewer:

The default CLS machine name for a standalone installation is **STANDALONE**. Do not change the CLS Machine name if the CLS Standalone option is installed.

Follow the steps below to relocate or correct the Licence Server node.

1. **Open License Status Viewer.**
2. Select:
   - **Tools > Change CLS Machine**
3. The Central License Server Machine Selection dialog box appears ([Figure 16](#)). Enter or browse for the node running the License Server.

![Central License Server Machine Selection](image)

*Figure 16. CLS Relocation Tool*

4. Click **Apply** to save the change.
5. Click **Exit** to return to the License Status Viewer.
6. Shut down and restart the node to apply the change.
Locate the License File

The license file contains the individual License. To locate the license file:

1. Open License Entry Tool.
2. Select:
   
   **View > File View**

3. The expected license file name is displayed at the top level in the tree view.
4. License files are stored in:
   
   Install Drive:\Program Files (x86)\ABB Industrial IT\ABBLicense\Licenses\Cache
   
   Use Windows Explorer to check if the specified directory and file exist.

Unavailable Machine IDs

This section describes what to do if an option is not listed as an available machine ID.

Dongles

If the desired USB port dongle is not listed as a machine ID option, verify the following:

1. Verify that the dongle was supplied by ABB. ABB software can read only ABB dongles.
2. Verify that the dongle is attached to the USB port.
3. Select:

   **Machine Ids > Available IDs**

   in the License Entry Tool to scan for newly inserted IDs.

MAC Address

If the MAC address is not listed as a machine ID option:

- Verify the TCP/IP protocol was properly configured during the installation of the product being licensed.
- Verify the network adapter is functioning correctly.
Table 2 lists the common error messages.

### Table 2. Common Error Messages

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message</th>
<th>Description / Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>8004AB1C/4AB1C</td>
<td>Error in registry entry for license file (License Group does not exist).</td>
<td>Requested group does not exist in the available groups. Open the license assignment editor to view the list of groups and features.</td>
</tr>
<tr>
<td>8004AB05/4AB05</td>
<td>No such feature exists.</td>
<td>This error occurs when checking out a feature that has been licensed. Open the license assignment editor to view the list of features.</td>
</tr>
<tr>
<td>8004AB09/4AB09</td>
<td>Feature found but machine ID mismatch.</td>
<td>A license for the feature was found, but not for the computer in use.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the license is for a moveable Machine ID (<a href="#">For example</a>: Rocky dongle) move the dongle to the computer in use. Or, get a license for the computer in use. Use the License Entry Tool and on IDs tab view the machine IDs.</td>
</tr>
<tr>
<td>8004AB0A/4AB0A</td>
<td>Feature found but wrong version.</td>
<td>License for the feature was found, but for a different version. Get a license for the latest version of the product.</td>
</tr>
<tr>
<td>8004AB0C/4AB0C</td>
<td>Feature expired.</td>
<td>The license validity for the feature was expired. Obtain the current license. Use the License Entry Tool and view the expiry date of the feature.</td>
</tr>
</tbody>
</table>
Appendix A  Diagnostic Information  Temporary Licence Error Message

Table 2. Common Error Messages

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message</th>
<th>Description / Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>8004AB81/4ABF1/4ABF2</td>
<td>Insufficient license quantity/Invalid License Granted: Available license quantity exceeded/Some licenses could not be granted due to insufficient quantity.</td>
<td>The program requires more license than were available. This error indicates license for the desired feature are available, but not in the quantity requested. Request fewer license or obtain more license. Click on the diagnostic button of license assignment editor to view the total requests for the desired feature.</td>
</tr>
<tr>
<td>8004AB83</td>
<td>Insufficient floating license quantity.</td>
<td>Possbile causes are either the use of one CLS server for more than one 800xA system or nodes not added in the system after recreation of system or client node point to the CLS system that is not part of corresponding 800xA system.</td>
</tr>
<tr>
<td>8004AB89/4AB89</td>
<td>The Client is not in the same System as the active SFA.</td>
<td>Possible causes are either the use of one CLS server for more than one 800xA system or nodes not added in the system after recreation of system or client node point to the CLS system that is not part of corresponding 800xA system.</td>
</tr>
<tr>
<td>4ABCA</td>
<td>A Hardware Key (Machine ID) has failed. You have %d hours remaining to correct the problem before licenses become invalid.</td>
<td>Possible causes are either the dongle removed from the node or it has stopped responding. Use the License Entry Tool, on the IDs tab view the machine IDs of the computer.</td>
</tr>
<tr>
<td>8004AB8C</td>
<td>A Hardware Key has stopped responding. Replace hardware key to correct.</td>
<td>Possible causes are either the dongle removed from the node or it has stopped responding. Use the License Entry Tool, on the IDs tab view the machine IDs of the computer.</td>
</tr>
</tbody>
</table>

NOTES:
%d indicates representation of an integer value corresponding to the total no of hours left over. By default it shows 48 hours and it decreases by one for every one hour.

Temporary Licence Error Message

A temporary licence error message appears in the following situations:

- The CLS Client is not able to reach the CLS Server.
- Internet Information Services (IIS) is not running in the CLS Server.
System Events for License Violations

In System 800xA, events for Licence violations are generated for following error messages (see Table 3).

Table 3. System Events for Common Error Messages

<table>
<thead>
<tr>
<th>Error Code</th>
<th>Error Message</th>
<th>Description / Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>8004AB05/4AB05</td>
<td>No such feature exists.</td>
<td>This error occurs when checking out a feature that has been licensed. Open the license assignment editor to view the list of features.</td>
</tr>
<tr>
<td>8004AB09/4AB09</td>
<td>Feature found but machine ID mismatch.</td>
<td>A license for the feature was found, but not for the computer in use. If the license is for a moveable Machine ID (For example: Rocky dongle) move the dongle to the computer in use. Or, get a license for the computer in use. Use the License Entry Tool and on IDs tab view the machine IDs.</td>
</tr>
<tr>
<td>8004AB0A/4AB0A</td>
<td>Feature found but wrong version.</td>
<td>License for the feature was found, but for a different version. Get a license for the latest version of the product.</td>
</tr>
<tr>
<td>8004AB0C/4AB0C</td>
<td>Feature expired.</td>
<td>The license validity for the feature was expired. Obtain the current license. Use the License Entry Tool and view the expiry date of the feature.</td>
</tr>
<tr>
<td>8004AB81/4ABF1/4ABF2</td>
<td>Insufficient license quantity/Invalid License Granted: Available license quantity exceeded/Some licenses could not be granted due to insufficient quantity.</td>
<td>The program requires more license than were available. This error indicates license for the desired feature are available, but not in the quantity requested. Request fewer license or obtain more license. Click on the diagnostic button of license assignment editor to view the total requests for the desired feature.</td>
</tr>
<tr>
<td>8004AB83</td>
<td>Insufficient floating license quantity.</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B  Related Documentation

Refer to [2] in Table 4 for a complete list of all product documentation applicable to the 800xA System that are included on the Release Notes/Documentation media provided with the system or available from ABB SolutionsBank. This document is provided in PDF format and is also included on the Release Notes/Documentation media. It is updated with each release and a new file is provided. Specific documents referred to in this user manual are presented in Table 4.

The asterisk (*) appended to each document number is a wildcard character used in place of the document revision. The wildcard allows searches in ABB SolutionsBank to be independent of revision. All revisions of the document will be displayed in the search result.

Table 4. Reference Documents

<table>
<thead>
<tr>
<th>Item</th>
<th>Title</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>[1]</td>
<td>System 800xA System Guide Functional Description</td>
<td>3BSE038018*</td>
</tr>
<tr>
<td>[2]</td>
<td>System 800xA Released User Documents</td>
<td>3BUA000263*</td>
</tr>
<tr>
<td>[3]</td>
<td>System 800xA Manual Installation</td>
<td>2PAA112455*</td>
</tr>
<tr>
<td>[4]</td>
<td>System 800xA Administration and Security</td>
<td>3BSE037410*</td>
</tr>
<tr>
<td>[5]</td>
<td>System 800xA 5.1 to 6.0 Upgrade</td>
<td>2PAA111694*</td>
</tr>
<tr>
<td>[6]</td>
<td>System 800xA 5.0 SP2 to 6.0 Upgrade</td>
<td>2PAA111695*</td>
</tr>
<tr>
<td>[7]</td>
<td>System 800xA 4.1 to 6.0 Upgrade</td>
<td>2PAA111696*</td>
</tr>
<tr>
<td>[8]</td>
<td>System 800xA 3.1 SP3 to 5.0 SP2 Upgrade</td>
<td>2PAA111697*</td>
</tr>
<tr>
<td>[9]</td>
<td>System 800xA System Guide Technical Data and</td>
<td>3BSE041434*</td>
</tr>
<tr>
<td></td>
<td>Configuration</td>
<td></td>
</tr>
<tr>
<td>[10]</td>
<td>System 800xA Tools</td>
<td>2PAA101888*</td>
</tr>
</tbody>
</table>
The revision index of this User Manual is not related to the 800xA 6.0 System Revision.

The following table lists the revision history of this User Manual.

<table>
<thead>
<tr>
<th>Revision Index</th>
<th>Description</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Published for 800xA System Version 6.0</td>
<td>December 2014</td>
</tr>
<tr>
<td>B</td>
<td>Published for 800xA System Version 6.0.1</td>
<td>October 2015</td>
</tr>
<tr>
<td>C</td>
<td>Published for 800xA System Version 6.0.3</td>
<td>September 2016</td>
</tr>
</tbody>
</table>
Contact us

www.abb.com/800xA
www.abb.com/controlsystems

Copyright © 2016 ABB.
All rights reserved.